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INSTRUCTOR NOTES
Getting Started
The Adobe® Acrobat® DC Classroom in a Book® course presents students with tips, 
techniques, and solutions for using the Adobe Acrobat DC software. The Instructor 
Notes are intended to complement the information in Adobe Acrobat DC Classroom 
in a Book. 

The information is organized to follow the sequence of instruction in each lesson. 

Course strategy
If you’re teaching a 15-session class, you can teach approximately one chapter of 
this book per class. The book contains 12 lessons, some of which may take a while  
to complete. If you are teaching a 10-session class, you may want to combine some 
of the lessons in a single class or make some of the lessons optional. For example:

• Lessons 4 and 5 cover enhancing and editing PDF files.

• Lesson 6 requires Microsoft Office for Windows applications. If students don’t 
use Microsoft Office, or work exclusively on Macintosh computers, they can skip 
lesson 6.

• Lesson 12 requires Acrobat Pro, as does much of Lesson 13, portions of Lesson 
3, and a few other exercises in the book. If students are using Acrobat Standard, 
they won’t be able to complete these lessons.

Managing student projects
One way to simplify file storage and retrieval in classroom situations is to ask stu-
dents to create a folder on their hard disks, name it [student’s name] Lessons, and 
then copy each project folder into the main Lessons folder. Having students keep all 
their working files in their own Lessons folder makes it easy for you to clean up files 
when a class is over.
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Lesson 1: Introducing Adobe Acrobat DC
The first lesson presents an overview of the Adobe Acrobat DC software, as well as 
Acrobat Reader. The lesson gives students a tour of the work area, pointing out the 
menu bar, task pane buttons, toolbars, and basic navigational elements. This lesson 
also demonstrates different ways of viewing PDF documents, including Full Screen 
mode and Read Mode. Students gain experience with the most basic and commonly 
used features, as they get to know their way around the work area. They’ll have 
the chance to see features in action, by rotating a page, adding a bookmark, and 
adding a comment. However, the main goal of this lesson is to help students know 
where tools and navigational options are located so that they can successfully work 
through the remaining lessons.

Goals for this lesson 
How much time you should schedule for this lesson depends on whether your 
students already have any knowledge of Acrobat and PDF documents, and on their 
computer skills in general. The overall objective for Lesson 1 is to help them become 
comfortable with Acrobat, which is an unusual application, in that you rarely create 
an original document in Acrobat. In general, they should be able to do the following:

• Describe the difference between Acrobat and Acrobat Reader. 

• Identify and name the key areas of the interface, including the menu bar, main 
toolbar, Page Controls toolbar, and Tools Center.

• Identify several advantages to working with Adobe PDF documents. 

• Enter and exit Read Mode. 

• Find common tools in the Tools pane.

• Describe how the user interface changes depending on the tool selected.

• Display comments.

• Customize the Quick Tools section of the toolbar.

• Navigate a PDF document using a variety of methods.

About PDF
Most students have probably received, opened, and printed PDF documents. 
However, they may not understand what PDF documents are are or what benefits 
they offer. To provide context for students, ask them about PDF documents they’ve 
used in the past. For example, some may have downloaded federal tax forms as PDF 
files, or they may have read PDF documents online. 
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About Acrobat
Acrobat is an unusual application, and it can be challenging for students to under-
stand how it differs from the applications they usually work with. Emphasize that 
when you’re creating a PDF document, you’re actually converting —or digitally 
printing—an existing document that was created in some other application. Once 
the file has been converted to PDF, you can read it, edit it, and make other changes 
to it in Acrobat.

About Acrobat Reader
Emphasize the difference between Adobe Acrobat, which is the full application that 
lets you create and edit PDF documents, and Acrobat Reader, the free application 
that lets you read PDF documents. While each version of Acrobat Reader includes 
additional features, it remains primarily a reader application, designed to allow any-
one, on any computer, to read a PDF document.

Working with the toolbars
Point out the differences between the main toolbar and the Page Controls toolbar  
so that students know how to find the tools they’re looking for quickly. 

Same tools, different locations
Ask students whether they’ve used AcrobatXI or earlier versions of the application. 
If they have, spend some time comparing the user interfaces. If students are brand 
new to Acrobat, changes in the user interface don’t affect them. 

For students who are familiar with earlier versions, note that the Acrobat DC work 
area is very different from that in Acrobat X and XI, and even more different from 
earlier versions. Invite students to select tools in Acrobat DC to see which tasks are 
grouped with each tool, and how the interface changes depending on the selected 
tool. Remind them to look in the Tools Center to see all the tools available.

Available tools
The lessons in this book cover both Acrobat DC Standard and Acrobat DC Pro. 
Several tools are available only in Acrobat Pro. If students are using Acrobat 
Standard, remind them that their screen may look different from the images  
in the book, which are all shown in Acrobat Pro.

To add a tool to the Tools pane, choose Add from the menu beneath it in the  
Tools Center.
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Navigating PDF documents
There are many ways to change pages or views in a PDF document. As students 
work through the exercises on changing magnification, accessing specific pages, 
using bookmarks, and splitting the view of a document, ask them to consider real-
life examples of when they would use each technique. For example, bookmarks are 
especially useful when navigating a long document with clear chapters or other 
definitive headings, while changing magnification may be essential to view a docu-
ment on a small screen or one that uses small type, such as a legal document.

Viewing PDF files in Read Mode
In Read Mode, most of the user interface is hidden, so that the reader can focus on 
the content of the PDF document. To navigate in Read Mode, move the pointer 
over the lower area of the document, and then click buttons in the semi-transparent 
floating toolbar. 

Point out to students that when you open a PDF file within a web browser, it may 
open in Read Mode, so it may not even be apparent to readers that they’re reading a 
PDF document.

Customizing the toolbar
If students are working on classroom computers, ask them to think about which 
tools they might add to the Quick Tools toolbar in Acrobat DC on their own com-
puters. They should consider adding the tools they use frequently, but not adding 
anything that would clutter up the toolbar unnecessarily. 

Getting Help
Encourage students to explore Adobe Acrobat DC Help so they are familiar with it 
as they work through the lessons in class, and especially so that they feel comfortable 
searching for help when they’re working on their own projects. 

Point out that they can search only Acrobat Help or a larger set of references, 
including third-party resources. You may also want to show them how to find tuto-
rials to help them learn more about features on their own. 
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Questions
The following questions are not in the student’s Classroom in a Book.

1 What is the difference between Acrobat and Acrobat Reader?

2 How can you return to the usual work area from Read Mode?

3  How can you split the document view?

Answers
1 Adobe Acrobat is the full application that you can use to create, edit, read, 

and work with PDF documents. Acrobat Reader is a more limited application, 
designed to let anyone read PDF documents, and it is available free.

2 To exit Read Mode, click the Show Main Toolbar button in the floating toolbar, 
or choose View > Read Mode.

3 To split the document view, choose Window > Split.

Lesson 2: Creating Adobe PDF Files
In most applications, you create a document by choosing File > New. In Acrobat, 
however, creating a document actually means converting a file from some other 
application to an Adobe PDF file. 

Goals for this lesson
At the end of this lesson, students should be able to describe multiple ways of 
creating a PDF file, and they should be able to identify the advantages of different 
methods.

Using the Create PDF tool
The exercise in the book instructs students to use the Create PDF tool to convert 
a TIFF file to a PDF document. Point out the other options in the Create PDF 
tool. Students will have a chance to use many of these options later in this lesson 
and in other lessons.

We provided a TIFF file for conversion because Acrobat can convert it without 
requiring any other application to be present on the computer. You can invite 
students to use the Create command to create PDF documents from other files so 
that they can see that the process is similar, though there are different conversion 
options available for different file types.
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Inserting a blank page
Ask students to brainstorm situations where they may want to add a blank page into 
a PDF document. Some examples might be the need to add blank pages to create a 
clear distinction between chapters in a book, to increase the total number of pages 
for folios in printing, or to add a notes page to a cookbook or textbook.

Using PDFMaker
Acrobat PDFMaker combines simplicity with control in the creation of PDF 
documents from several applications. Students will have the opportunity to use 
PDFMaker in Lesson 6, creating PDF documents from Microsoft Office applications 
in Windows. Additionally, they can use PDFMaker to convert web pages to PDF 
from Microsoft Internet Explorer, Google Chrome, or Mozilla Firefox.

Note that Acrobat PDFMaker is available only for Windows applications, with the 
exception of Firefox. 

Using the Print command to create Adobe PDF files
This section is actually two separate exercises: one for students using Windows and 
one for those using Mac OS. Though you can use the Print command to create a 
PDF file from any application on either platform, how you do it on each platform is 
actually quite different. 

In Windows, you use the Adobe PDF printer, which is installed with Acrobat, to 
“print” your application to PDF. There is no Adobe PDF printer in Mac OS, because 
Mac OS includes PDF creation in its operating system. However, emphasize for stu-
dents that they should choose Save As Adobe PDF to create Adobe PDF files. Other 
options create PDF files using the Mac OS defaults, which do not use Acrobat and 
may result in lower-quality PDF files. 

Reducing file size
The Reduce File Size dialog box provides only one choice—version compatibility. 
While you can significantly reduce the file size by selecting a different version of 
Acrobat for compatibility, you don’t have much control over how that reduction 
occurs. 

Show students the additional options available in the PDF Optimizer dialog box, 
discussed briefly in the “Optimizing PDF files (Acrobat Pro)” section of the book. 
To open the dialog box, choose File > Save As Other > Optimized PDF. 

In most cases, the default settings are appropriate for maximum efficiency—saving 
space by removing embedded fonts, compressing images, and removing items from 
the file that are no longer needed.
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Before you optimize a file, it’s a good idea to audit the file’s space usage. Click the 
Audit Space Usage button at the top of the dialog box. The space audit results may 
give you ideas about how you can most efficiently reduce file size. 

To change the options in the PDF Optimizer dialog box, select the check box next 
to a panel (for example, Images, Fonts, Transparency), and then select options in 
that panel. 

For information on the options in the PDF Optimizer dialog box, see “PDF 
Optimizer Options” in Adobe Acrobat DC Help. 

Making scanned text editable and searchable
If students scanned documents in the previous exercise, suggest that students apply 
OCR to those documents, too, and see how well it recognizes the characters. 

Converting web pages to Adobe PDF
Students may prefer to convert the web pages for their school or organization. It 
doesn’t matter which web pages they convert; the process is the same. 

Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you convert and combine multiple files into a single PDF file?

2 How can you reduce the file size of a PDF document?

Answers
1 To convert and combine multiple files into a single PDF file, open the Create 

PDF tool, select Multiple Files, select Combine Files, click Next, and then select 
the files you want to combine.

2 To reduce the file size of a PDF document, choose File > Save As Other > 
Reduced Size PDF, and then select a version compatibility option. Or, if you’re 
using Acrobat Pro, you can choose File > Save As Other > Optimized PDF, and 
then select optimization settings.
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Lesson 3: Reading and Working with PDF Files
This lesson gives students more experience with navigation, and then introduces 
a number of features that help make PDF documents more useful to readers. For 
example, students learn to search, make PDF documents accessible, print, and fill 
out a PDF form.

Goals for this lesson 
When they complete this lesson, students should be able to use several methods to 
navigate a PDF document efficiently, search PDF files for specific content, assess the 
accessibility of a PDF file, and make a PDF file more accessible. They should also be 
able to complete a form that is sent to them, and to print all or a portion of a PDF 
document.

Searching PDF documents
The main difference between the Find command and the Advanced Search com-
mand is that the latter gives you options for how the search should be conducted. 
Additionally, the Advanced Search feature can search multiple documents at once. 

Students may want to use both features to search for the same text in a document, 
and then compare the results depending on the search options they select in the 
Search pane.

Printing PDF documents
Which options appear in the Print dialog box depend on what you have selected 
in the PDF document. If multiple thumbnails are selected in the document, the 
Selected Pages option is available. If no thumbnails are selected, the Current View 
option is available. If students don’t see the Current View option in the dialog box, 
make sure they’ve deselected the thumbnails before closing the Page Thumbnails 
panel. 

This lesson covers basic printing options in the Print dialog box. Lesson 12 covers 
more advanced options for professional printing. 

Filling out PDF forms 
You can let students fill out the entire form, save it, or print it, so they can gain more 
experience working with forms as a form recipient. In Lesson 10, they’ll learn how 
to create their own interactive forms in Acrobat.



Adobe Acrobat DC Classroom in a Book 11

Making files flexible and accessible
Students who are using Acrobat Standard won’t be able to use the Accessibility 
Checker or the Tags panel. However, point out that you can add tags and Alt text  
in Acrobat Standard the Accessibility tool.

For more information about tags, Alt text, and other accessibility topics, see Adobe 
Acrobat DC Help.

Questions
The following questions are not in the student’s Classroom in a Book.

1 What does the Hand tool do?

2 How can you share a PDF document using Adobe Send?

Answers
1 The Hand tool lets you pan a document by dragging it across the application 

window.

2 To share a document using Adobe Send, click the Send Email button in 
the toolbar, and choose Send & Track. Create an anonymous link or send 
personalized invitations if you want to track who views the document. 

Lesson 4: Enhancing PDF Documents
Lesson 4 covers a range of Acrobat tasks that help you customize a PDF file and 
manipulate its pages. Students will learn how to accomplish many of the tasks 
that need to be performed to prepare a PDF file for distribution after it’s initially 
created.  

Goals and objectives for this lesson
After completing this lesson, students should be comfortable evaluating a PDF file 
to determine what needs to be done to finalize it, as well as performing tasks such  
as deleting or inserting pages, editing links and bookmarks, renumbering pages, 
specifying initial view settings, and inserting video files. 

Moving pages with page thumbnails
This is the third time students have worked with page thumbnails. First, they used 
them to navigate a document, and then they used them to select pages for printing. 
Now, they’ll use them to change the order of pages in the PDF. This is a great oppor-
tunity to refresh their memories about those earlier tasks.
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Manipulating pages
The exercises show students how to rotate and delete pages. You may also want to 
show them how to extract pages, or you may want to wait and talk about extracting 
pages when students export pages in Lesson 5.

Renumbering pages
Because renumbering pages in Acrobat doesn’t change the page number printed on 
each page, this feature can be confusing to students. Point out to them that there 
are essentially two page numbers involved: the position of the page in the full PDF 
file and the “official” page number assigned to each page. Often, these are the same 
number. But in many cases, you’ll want to assign different page numbers to the front 
matter of a book, or start page numbering after the cover page of a document. In 
those cases, renumbering pages will keep viewers on track. 

Editing links
Moving back and forth between the linked pages and the Table of Contents page 
can be very tedious. Encourage students to add the Previous View button to the 
toolbar so they can quickly jump back to the contents page after testing each link.

When students create a link for page 10, point out the other options in the Create 
Link dialog box. In addition to linking to a page within the document, you can link 
to an external file or website. 

Working with bookmarks
When repositioning bookmarks, remind students that they nested a bookmark in an 
earlier lesson. Invite them to nest additional bookmarks now, so they can become 
comfortable positioning the bookmark appropriately to move it to different levels. 

Changing the initial view
The first impression of a document can determine whether a reader feels comfort-
able with the content or overwhelmed, or even knows that navigational tools such as 
bookmarks are available. When deciding which settings to use for initial view, keep 
your audience in mind. For what purpose will a reader be opening the document? If 
it’s to read a text straight through, your goal may be to make the view as inviting and 
uncluttered as possible. If someone opening the PDF document is likely to need to 
access a specific section somewhere in the body of the document, displaying book-
marks can help them find what they’re looking for faster.
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In addition to the initial views set in the exercise, invite students to select other set-
tings to see how they affect the first impression of the document. Remind students 
that to see changes you make to the initial view, you need to save the document, 
close it, and then open it again. 

Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you rotate a page in a PDF file?

2 How do you create a link to another page?

1 How can you change the initial view for a PDF document?

Answers
1 To rotate a page, open the Organize Pages tool, select the page, and click one of 

the rotation icons. Or select the thumbnail for the page in the Page Thumbnails 
panel, and then select a rotation icon at the top of the panel. 

2 To create a link to another page, open the Edit PDF tool, and then choose Link 
> Add or Edit from the Edit PDF toolbar. Drag a border for the linked area. In 
the Create Link dialog box, select Go To A Page View, and click Next. Then 
navigate to the page you want to link to, and click Set Link.

1 To change the initial view for a document, choose File > Properties. In the 
Document Properties dialog box, click the Initial View tab. Then change the 
settings, click OK, and save the document.

Lesson 5: Editing Content in PDF Files
In Acrobat DC, you can edit text and images in PDF files. As you modify text in a 
PDF, Acrobat reflows the text intelligently. This lesson gives students practice edit-
ing text and images, and reusing PDF content in other applications. 

Goals and objectives for this lesson
After completing this lesson, students should be able to add or modify text in PDF 
files, replace and crop graphics, copy content to the pasteboard, and export text, 
images, and tables to Microsoft Office application formats.
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Editing text
Exercises in this lesson give students the opportunity to remove entire blocks of 
text, make simple edits, and add a bullet point item. If they have time, encourage 
students to make additional changes to text on different pages to understand how 
text reflows, and let them experiment more with text formatting options.

Redacting text
Most students won’t need to redact text. However, if your students work in a legal 
setting or in administrative offices, they may need to know how to redact text in 
PDF documents. If they’re using Acrobat Pro, show them the Redact tool, and then 
demonstrate how to use it. 

• Before redacting text, click Properties in the Redact toolbar to specify the 
redaction appearance and how the saved file should be named. 

• Choose Mark For Redaction > Find Text in the Redact toolbar. Then enter the 
words, phrases, or number patterns (such as Social Security numbers) that you 
want to remove, and click Search And Remove Text.

• In the Search panel, click items to see them in context. Click Check All to select 
them all. Click Mark Checked Results for Redaction to select them for removal.

• When you’ve selected your redactions in the Search panel, click Apply in the 
Redact toolbar. Then save the document.

Editing an image in another application
Ensure students understand the types of changes they can make to an image in 
Acrobat, and why they might need to edit an image in another application. You can 
make changes to the image’s position or size in Acrobat: you can rotate it, flip it, 
crop it, replace it, or move it. If you want to add a filter, change the lighting, adjust 
color, add drawn elements, or perform other changes to the content of the image, 
you need to edit it in an application such as Adobe Photoshop.

The exercise invites students to make a change in Photoshop or another image-
editing application. Remind them that the change should be something obvious,  
and that it doesn’t need to look good or match the PDF file. For demonstration  
purposes, a large black box or a colorful squiggle can work well. 

Copying text and images from a PDF file
When you paste text into an authoring application, how the text is formatted 
depends on the application settings and whether a font has been substituted. In 
most cases, you’ll need to make some adjustments after pasting the text. In this 
exercise, it’s unlikely that students have the font that was used to create the bullets 
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in the original PDF file, so those characters will probably be substituted with char-
acters from a resident font.

Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you add a bullet point to text in a PDF file?

2 How would you crop an image in Acrobat?

3 How do you add an image to a PDF file?

Answers
1 To add a bullet point to an existing list in a PDF file, open the Edit PDF tool, 

click an insertion point after the final bullet item, and press Enter or Return. 

2 To crop an image in Acrobat, open the Edit PDF tool, select the image, click the 
Crop icon in the Format area of the right-hand pane, and then drag the edges of 
the image inward.

3 To add an image to a PDF file, open the Edit PDF tool, click Add Image in the 
Edit PDF toolbar, select the image you want to add, and then place it on the 
page. 

Lesson 6: Using Acrobat with Microsoft Office 
Files (Windows) 
Acrobat PDFMaker makes it much easier to create PDF files from Microsoft 
Word, Excel, or PowerPoint documents. This lesson walks students through using 
PDFMaker in each of those applications. 

Goals and objectives for this lesson
After completing this lesson, students should understand the PDFMaker options 
available in Word, Excel, and PowerPoint.

Getting started
Acrobat PDFMaker is not available for Microsoft Office for Mac OS. Students who 
use Mac OS, or who don’t use Microsoft Office applications, may want to skip this 
lesson.

The primary instructions in the lesson assume the student is using Microsoft Office 
2013, but the instructions are similar for Office 2007 and later. (Earlier versions of 
Microsoft Office are not support by PDFMaker for Acrobat DC.)
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About Acrobat PDFMaker
PDFMaker includes several conversion settings, many of which are specific to an 
application. Encourage students to experiment with different settings to see how the 
resulting PDF files differ. 

Settings included in most PDFMaker-enabled applications:

Attach Source File attaches the document being converted to the PDF.

Create Bookmarks converts certain elements in original Office documents to PDF 
bookmarks: Word headings, Excel worksheet names, or PowerPoint titles. Selecting 
this option overrides any settings on the Bookmarks tab of the Conversion Settings 
dialog box.

Add Links includes active links and hypertext in the PDF.

Enable Accessibility And Reflow With Tagged Adobe PDF embeds tags in the PDF.

Word-specific settings (Word tab)

Convert Displayed Comments To Notes In Adobe PDF changes any Word com-
ments to PDF comments. If the currently open Word document contains com-
ments, more options appear in the Comments list on this tab:

Reviewer lists the names of reviewers who have entered comments in the current 
Word document.

Include includes the comments in the PDF.

Notes Open specifies whether the PDF comment windows automatically open or 
are closed for that reviewer’s comments.

Color shows the color for that reviewer’s comment icons. Clicking the color icon 
repeatedly cycles through a limited set of available colors.

# Of Comments shows the number of comments that the reviewer made.

Convert Cross-References And Table Of Contents To Links (Word 2002 and 
2003 only) enables one-click navigation of these elements in the new PDF. This 
option is not available in Word 2007.

Convert Footnote And Endnote Links integrates these into the PDF.

Enable Advanced Tagging integrates tags into the PDF.
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Word-specific settings (Bookmarks tab)

The options you specify on this tab determine which items are converted into PDF 
bookmarks in the PDF.

Important: To include bookmarks in the conversion process, the Add Bookmarks 
To Adobe PDF option on the Settings tab must be selected. If you deselect that 
option, it overrides any options you select on this tab and no bookmarks are created.

Convert Word Headings To Bookmarks selects all the headings in the Elements 
list for conversion to PDF bookmarks. 

Convert Word Styles To Bookmarks selects all the text styles in the Elements list 
for conversion to PDF bookmarks. (This option is unselected by default.)

Convert Word Bookmarks converts any user-created Word bookmarks to PDF 
bookmarks.

Element list specifies which Word headings and styles are converted to PDF 
bookmarks.

Element lists the names of all available Word headings and styles. The icons for 
Headings  and Styles  indicate the element types.

Type also indicates whether the element is a heading or style in the Word 
document.

Bookmark displays X’s, indicating whether individual elements are converted to 
PDF bookmarks. Clicking an individual Bookmark option changes the selection 
status for that element.

Level specifies where the element fits in the hierarchy structure of the PDF 
Bookmarks panel. Clicking an individual Level number opens a menu that you can 
use to change the value.

Excel-specific settings

Convert Comments converts user-created Excel comments to notes and lists them 
in the Acrobat Comments panel.

Fit Worksheet To A Single Page adjusts the size of each worksheet so that all the 
entries on that worksheet appear on the same page of the PDF.

Fit To Paper Width adjusts the width of each worksheet so that all the columns  
on that worksheet appear on one page in the PDF.

Prompt For Selecting Excel Sheets opens a dialog box at the beginning of the 
file conversion process. In this dialog box, you can specify which worksheets are 
included in the PDF and the order in which the sheets appear in the PDF.
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PowerPoint-specific settings

Convert Multimedia converts linked audio-video files to an FLV file and embeds  
it in the PDF.

Preserve Animation (PowerPoint 2003 only) converts any animation effects in the 
PowerPoint file to equivalent animations in the PDF. This option is not available in 
PowerPoint 2007 or later.

Preserve Slide Transitions converts PowerPoint slide transition effects to PDF 
transition effects.

Convert Hidden Slides To PDF Pages converts any PowerPoint slides that are not 
seen in the usual playing of the presentation to PDF pages.

Convert Speaker Notes converts any speaker notes for the PowerPoint presenta-
tion into Text notes in the PDF. 

Use PowerPoint Printer Settings (PowerPoint 2003 only) uses the same printer 
settings in the PDF as in the original file. This option is not available in PowerPoint 
2007 or later.

Converting Microsoft Word files to Adobe PDF
For tips on converting Word documents to PDFs, see Troubleshooting PDF-
creation issues in Microsoft Word at www.acrobatusers.com/tutorials/
troubleshooting-pdf-creation-issues-microsoft-word.

Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you preserve the comments in a Word document when you save  
it as a PDF file?

2 How can you create a tagged PDF file from an Excel spreadsheet?

Answers
1 To convert Word comments to PDF notes, click the Word tab in the Acrobat 

PDFMaker dialog box, and select Convert Displayed Comments To Notes In 
Adobe PDF.

2 To create a tagged PDF file from an Excel spreadsheet, on the Settings tab in the 
Acrobat PDFMaker dialog box, select the Enable Accessibility And Reflow With 
Tagged Adobe PDF options.
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Lesson 7: Combining Files 
You can combine files of multiple formats into a single PDF file; each file is con-
verted to PDF as you combine them, as long as you have the file’s authoring 
application installed. If you use Acrobat Pro, you can opt to create a PDF Portfolio, 
instead, which can include unconverted files as well as PDF files.

Goals and objectives for this lesson
Students should be able to combine files into a single PDF, selecting and arranging 
individual pages for the final PDF. They should understand that files are converted 
to PDF in the process, and be able to explain why some files cannot be included in 
a combined PDF file if the source application isn’t installed. Additionally, students 
should be aware of PDF Portfolios and be able to describe how PDF Portfolios differ 
from documents combined using the Combine Files Into A Single PDF command.

Browsing files
By default, Acrobat displays thumbnails in the Combine Files dialog box. In Mac 
OS, it must open the file’s source application to display its thumbnail. For example, 
if you’re including a Word document in the combined file, Acrobat opens Word so 
that it can display a thumbnail of the file. Having the applications open in the back-
ground can be disconcerting until students understand that Acrobat is using them. 

Creating a PDF Portfolio
The lesson’s focus is on creating a single PDF from multiple documents. However, if 
students are using Acrobat Pro, encourage them to create a PDF Portfolio using the 
lesson files or their own files. The sidebar, “Creating a PDF Portfolio (Acrobat Pro),” 
provides general steps. 

Though you must have Acrobat Pro to create PDF Portfolios, they can be opened in 
Reader or Acrobat Standard as well. 

Ask students what they might use PDF Portfolios for. High school students might 
use a PDF Portfolio to present materials for a college application process. College 
students may assemble documents for a job interview. Adult learners may anticipate 
creating a PDF Portfolio to assemble the components of a presentation or project, or 
to present documents, images, and video related to a family vacation. PDF Portfolios 
can be used any time you want to pull together multiple documents with various 
formats to archive, present, or distribute.
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Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you see a list of included files in the Combine Files dialog box?

2 Do you need Acrobat Pro to view a PDF Portfolio?

Answers
1 To view the files as a list instead of thumbnails, click the Switch To List button at 

the top of the Combine Files dialog box. 

2 No. You can view a PDF Portfolio using Acrobat Reader, Acrobat Standard, or 
Acrobat Pro.

Lesson 8: Adding Signatures and Security
Many students have concerns about distributing PDF files, especially after they see 
how much you can edit a PDF file in Acrobat. This lesson gives students the power 
to control who edits a PDF file—and even who has access to open it. Additionally, 
students learn about digital signatures, which are gaining wider acceptance in the 
business world. 

Goals for this lesson
At the end of this lesson, students should be able to describe the difference between 
security that prevents people from opening PDF documents without a password and 
security that limits the changes that can be made to a document. They should also 
be familiar with the concept of digital signatures, know how to create a self-signed 
digital ID in Acrobat, be comfortable using the Signatures panel, and understand 
the difference between using certificates to sign a document and using Adobe eSign 
(formerly Adobe EchoSign). 

Viewing documents in Protected mode (Windows)
Protected mode, called sandboxing by IT professionals, prevents PDF files opened in 
Acrobat Reader from creating mischief on your system. Protected mode is available 
only in Acrobat Reader X and later for Windows, and it’s on by default. 
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For most people, Reader works exactly as expected when documents are opened 
in Protected mode. However, it can interfere with some screen-reader applications 
and some third-party Reader plug-ins. Instructions for turning Protected mode 
off are in the student’s book, but emphasize that they should turn it off only if 
they run into a specific problem. Otherwise, it’s best to leave it on to protect their 
computers.

Adding security to PDF files
Most students find the concept of setting a password to limit who opens a PDF 
document straightforward. However, the password that limits changes can be a little 
more confusing. 

You might find it helpful to explain it to students this way: You’re setting limits on 
the kinds of changes people can make in the PDF file. No one can remove those 
limits without the password. 

We’ve provided a password that may be used each time a password is required. Of 
course, students should create their own passwords when working with their own 
files, and they can do so when working through this lesson, as long as they remem-
ber what those passwords are. Encourage students to try different combinations 
to see which passwords Acrobat identifies as strong and which as weak. It’s useful 
to understand how to create strong passwords in many applications, not just in 
Acrobat. 

About eSign
Adobe eSign is a convenient, secure utility for signing documents electronically, 
available to anyone with an Adobe Document Cloud or Adobe Creative Cloud 
subscription.  

About digital signatures
For the purposes of this lesson, students create a self-signed digital ID, but third-party 
digital IDs are often more secure. For information about working with third-party 
digital IDs, see “Creating or obtaining digital IDs” in Adobe Acrobat DC Help. 

If students don’t use digital signatures right away, they may not remain comfortable 
with them, so it’s a good idea to point out the sections in Adobe Acrobat DC Help 
that can assist them when they need to work with signatures in the future.
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Questions
The following questions are not in the student’s Classroom in a Book.

1 What makes a password stronger?

2 How can you add an eSign-compatible signature field to a document?

Answers
1 Stronger passwords include both uppercase and lowercase letters, numbers, 

punctuation marks, and symbols. Longer passwords also tend to be harder  
to guess, and therefore stronger.

2 To add a digital signature field for use with eSign, open the Prepare Form tool, 
select the Add Signature tool in the Prepare Form toolbar, drag a signature field 
on the page, and make sure either Sender or a Signer version is chosen in the 
Who Needs To Sign This Field menu in the field’s properties.

Lesson 9: Using Acrobat in a Review Cycle
Acrobat can help make review processes much simpler and faster than traditional 
review processes, requiring multiple cycles of marked-up printed documents. This 
lesson covers the basic concepts of review processes using Acrobat, and gives stu-
dents experience using Acrobat in an email-based review.

Goals for this lesson
Students should know how to add comments to a PDF file, and should understand 
which commenting tools are useful for specific purposes. They should be able to 
explain the basic review process and know how to initiate a review. 

Adding comments to a PDF file
Acrobat provides a wide variety of commenting tools, including tools for text edits, 
drawing tools, and the familiar Sticky Note tool. You may find it useful to refer back 
to the descriptions of the tools as students begin adding comments. Though the 
exercises lead students through adding several specific comments, they don’t have 
to limit themselves to those comments. If you have time, encourage students to try 
out each of the commenting tools in the PDF document, so that they can get a feel 
for when they’d use each one.
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Working with comments
One of the lesson files students import is an FDF file, which includes exported  
comments but does not contain the entire PDF file itself. As a supplemental exercise, 
you can instruct students to export the comments they created in their document 
to an FDF file that they can then import into the original PDF document.

To export comments to an FDF file:

1 Add the comments you want to include.

2 From the options menu in the Comments list, choose Export All To Data File.

3 Name the file, and choose Acrobat FDF Files (*.fdf) for the file type.

4 Specify a location for the file, and then click Save.

Initiating an email-based review
A classroom setting is ideal for practice with an email-based review. Before begin-
ning this exercise, you may want to assign students to workgroups and ask members 
of each workgroup to exchange email addresses so they can participate in reviews 
together. Groups of three to four people should give students an opportunity to 
experience a real-world review cycle. 

Questions
The following questions are not in the student’s Classroom in a Book.

1 What is an FDF file, and how do you create one?

2 Which commenting tools are available in Acrobat Reader?

Answers
1 An FDF file is a file that contains additional data (such as comments or form 

data) for a PDF file, but not the original PDF file itself. To export comments 
to an FDF file, choose Export All To Data File from the options menu in the 
Comments list, choose Acrobat FDF files (*.fdf) for the file type, and then click 
Save.

2 Acrobat Reader DC includes all the commenting tools automatically.
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Lesson 10: Working with Forms in Acrobat
Interactive forms streamline the process of filling in and collecting data. 
Respondents can fill in forms using either Acrobat or the free Acrobat Reader.  
In this lesson, students convert a static form to an interactive form, distribute it, and 
analyze the responses.

Goals for this lesson
Students should be able to convert a document into an interactive form. They 
should feel comfortable distributing the form, and working with the form responses 
in the PDF Portfolio Acrobat creates for them.

Adding form fields
You can invite students to create additional form fields to experiment with types 
of fields, including buttons, check boxes, list boxes, and other options. Emphasize 
the difference between radio buttons and regular buttons, which apply actions. 
Additionally, make sure students understand the difference between radio buttons, 
which allow you to select only one option, and check boxes, which let the respon-
dent select multiple options.

Distributing forms
In a classroom setting, you may want to divide the class into workgroups and ask stu-
dents to exchange their email addresses with other members of their workgroup before 
beginning this exercise. Ideally, students will distribute forms to at least two other 
people and therefore have two sets of comments to import into the response file.

Collecting form data
When you distribute a form, Acrobat automatically creates a PDF Portfolio for col-
lecting the data submitted by users. By default, this file is saved in the same folder as 
the original form and is named filename_responses. You can use this file to compile 
returned forms. 

The PDF Portfolio Acrobat creates for the response file is a bit different from the 
PDF Portfolios students created in Lesson 7. Point out that each returned form 
appears as a separate component file in the PDF Portfolio.

Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you create a form field that accepts multiple lines of text?

2 What is Tracker?



Answers
1 To create a multiline text field, select Text Field in the Prepare Form toolbar. 

Drag a text field, and then double-click it to view its properties. Click the 
Options tab, select Multi-line and Scroll Long Text, set a character limit if you 
want to, and then click Close.

2 Tracker is a utility in Acrobat that lets you track forms you’ve distributed. 
It displays the date you sent the form, the recipients, and whether they’ve 
responded. You can also use Tracker to send reminder email or send a form  
to additional people. Tracker also helps you manage reviews.

Lesson 11: Using Actions (Acrobat Pro)
Acrobat DC Pro includes actions, collections of steps that help you automate pro-
cesses and make them more consistent. Some students may be familiar with actions 
in Photoshop, but actions in Acrobat are quite different. Instead of recording a 
series of steps, as you do in Photoshop, you build a custom wizard that performs 
some steps automatically and prompts the user to perform others.

Goals of this lesson
Upon completing this lesson, students should understand what an action is and how 
to use one. They should also be able to create a custom action, including instruction 
steps, and know how to share an action with colleagues.

Using predefined actions 
Acrobat DC Pro comes with several actions already in the Action Wizard tool. The 
exercise instructs students to run the Prepare for Distribution action. After they run 
the action, you may want to invite students to select other actions and read their 
opening screens to see which steps are included in each action. Doing so will give 
students an idea of other actions that are already in place for them to use, and it will 
also help them conceptualize how actions are built, which will be useful when they 
create an action in the next exercise.

Creating an action
As students create the action described in the exercise, ask them to notice which tasks 
are available to be included in actions. Any tasks that aren’t included in the list on the 
left in the Create New Action dialog box can only be added using instruction steps. 



After students create the action, ask them to consider what processes or procedures 
they perform in Acrobat that could be helped with an action. Any process that 
needs to be done the same way each time—especially if multiple people perform 
the same process—is a good candidate for an action, as is any multi-step process 
that could be done automatically by Acrobat. Students might mention preparing 
monthly newsletters for distribution, for example, or assembling annual reports. 
They might talk about specific review or approval processes that require particular 
steps be completed. The goal is to help students prepare to use this feature in their 
own work. 

Questions
The following questions are not in the student’s Classroom in a Book.

1 How do you run an action?

2 How can you import an action someone else has shared with you?

Answers
1 To run an action, open the Action Wizard tool, select the action in the Actions 

list in the right-hand panes, review the steps, and click Start.

2 To import an action, open the Action Wizard tool, click Manage Actions in the 
Action Wizard toolbar, and click Import. Then navigate to and select the .sequ 
file you want to import.

Lesson 12: Using Acrobat in Professional 
Printing
Many of the lessons in this book cover aspects of working with PDF files electroni-
cally: distributing forms, sending files for review, and so on. This lesson specifically 
covers printing PDF files professionally. While print production professionals may 
find this a useful introduction to the features in Acrobat, the lesson is intended as 
a primer for students preparing to hand off PDF files to a print production service 
provider.

Goals of this lesson
Students should learn how to prepare an Adobe PDF file for professional printing. 
They’ll gain familiarity with printing concepts, such as color management, transpar-
ency flattening, and preflighting, and be better able to follow instructions provided 
by print professionals.
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Guidelines for creating print-ready PDF files
This sidebar is probably the most important part of this lesson. Encourage students 
to read it carefully, and discuss each of the bullet points. Some of the terms will make 
more sense to them after they’ve completed the lesson. Refer back to this sidebar as 
you discuss transparency, color management, and PDF presets later in the lesson. 

Creating PDF files for print and prepress
Communication is key when preparing files for print. Encourage students to request 
guidelines or any specific requirements from their printer before they design the 
document they plan to print. Early communication prevents the need to rework the 
document later. When it comes time to create the PDF file, students should follow 
the print professional’s instructions for choosing a preset, which may be the Press 
Quality settings file, a standard such as a PDF/X preset, or a custom preset that the 
print professional provides.

Preflighting files (Acrobat Pro)
To verify that your Adobe PDF file contains only the features, fonts, and formatting 
that you intend, use the Preflight tool to inspect and, in certain cases, correct the 
document’s contents. Catching errors before you hand off the PDF file can save you 
time and money.

Setting up color management
A color management system reconciles color differences among devices so that you 
can confidently predict the colors your system ultimately produces. Viewing color 
accurately allows you to make sound color decisions throughout your workflow, 
from digital capture through final output. 

Color management for a file shouldn’t begin in Acrobat, which is the end of the 
desktop workflow. Rather, color management should be in place when the file is cre-
ated, especially if you’re working with photographic images. Suggest that students 
look into color management features in the applications they use to produce their 
documents. If they use Adobe Creative Cloud applications, they can synchronize 
color management settings. For more information, see Adobe Creative Cloud Learn 
and Support.
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Questions
The following questions are not in the student’s Classroom in a Book.

1 How can you preview transparency flattening?

2 What is a soft proof?

Answers
1 To preview transparency flattening for a document, open the Print Prodcution 

tool, and select Flattener Preview in the right-hand pane.

2 A soft proof is a proof that takes place on the computer, so you don’t need to 
print the document. When you perform a soft proof, you change settings so that 
your monitor matches the settings you expect to occur on your output device. 


